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Pos: 1 /TD/Überschriften/MUF/Sicherheit und Umwelt @ 3\mod_1234793958627_79.doc @ 26223 @ 1 
 

1 Safety and the environment 
Pos: 2 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Elektrische Gefahren vermeiden @ 3\mod_1234794609299_79.doc @ 26280 @ 5  

Avoiding electrical hazards 
> Never use the instrument and connected probes to measure on 

or near live parts! 
> Damaged mains cables must only be replaced by authorized 

personnel. 
> Only have the transmitter wired and connected by authorized 

personnel with the voltage disconnected. 
> You must always comply with the regulations applicable in your 

country for opening and repairing electrical equipment. 
Pos: 3 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Personen- und Sachschäden vermeiden @ 3\mod_1234794744768_79.doc @ 26299 @ 5 
 

Avoiding personal injury and damage to equipment 
> Installation, setting and calibration work must only be carried 

out by qualified and authorized personnel! 
> Only open the instrument when this is expressly described in 

the instruction manual for installation, maintenance or repair 
purposes. 

> Observe the permissible storage, transport and operating 
temperature. 

Pos: 4 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Nicht mit Lösungsmitteln lagern @ 0\mod_1175692375179_79.doc @ 583 @  
 

> Do not store the product together with solvents. Do not use any 
desiccants. 

Pos: 5 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Bei Wartung MUF nicht zur Regelung verwenden @ 3\mod_1234794852377_79.doc @ 26318 @  
 

> Do not use the instrument for control purposes at the same time 
as operating or servicing the transmitter. 

Pos: 6 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Produkt bestimmungsgemäß verwenden @ 0\mod_1173781261848_79.doc @ 386 @  
 

> Only operate the product properly, for its intended purpose and 
within the parameters specified in the technical data. Do not 
use any force. 

Pos: 7 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Nur beschriebene Wartungsarbeiten durchführen @ 0\mod_1175692705195_79.doc @ 601 @  
 

> Carry out only the maintenance and repair work on this 
instrument that is described in the documentation. Follow the 
prescribed steps exactly. Use only original spare parts from 
Testo.  

Pos: 8 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Fachpersonal @ 3\mod_1234794940409_79.doc @ 26337 @  
 

Any additional work must only be carried out by authorized 
personnel. Otherwise testo will not accept any responsibility for the 
proper functioning of the instrument after repair and for the validity 
of certifications. 



2 About this document 

4 

Pos: 9 /TD/Überschriften/MUF/Umwelt schützen @ 3\mod_1234858757571_79.doc @ 26363 @ 5 
 

Protecting the environment 
Pos: 10 /TD/Sicherheit und Umwelt/Umwelt schützen/Produkt entsorgen @ 0\mod_1173780307072_79.doc @ 357 @   

> At the end of its useful life, send the product to the separate 
collection for electric and electronic devices (observe local 
regulations) or return the product to Testo for disposal.  

Pos: 11 /TD/Überschriften/MUF/Zu diesem Dokument @ 3\mod_1234793991331_79.doc @ 26242 @ 1 
 

2 About this document 
Pos: 12 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Verwendung (Standard) @ 0\mod_1173775068554_79.doc @ 337 @ 5 
 

Use 
> Please read this documentation through carefully and 

familiarize yourself with the product before putting it to use. Pay 
particular attention to the safety instructions and warning advice 
in order to prevent injuries and damage to the products. 

> Keep this document to hand so that you can refer to it when 
necessary.  

> Hand this documentation on to any subsequent users of the 
product. 

Pos: 13 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonventionen/Warnhinweis WARNUNG @ 2\mod_1207646966234_79.doc @ 14398 @   

 WARNING Indicates potential serious injuries 
 Pos: 14 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonventionen/Warnhinweis VORSICHT @ 2\mod_1207651416515_79.doc @ 14416 @  
 

 CAUTION indicates potential minor injuries 
 
Pos: 15 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonv. Software [Standard] @ 0\mod_1190203332543_79.doc @ 4883 @ 5  

Symbols and writing standards 
 

Representa-
tion  

Explanation  

 
Note: Basic or further information. 

1. ... 
2. ... 

Action: more steps, the sequence must be 
followed. 

> ... Action: a step or an optional step. 
- ... Result of an action. 
Menu Elements of the program interface. 
[OK] Buttons of the program interface.  
... | ... Functions/paths within a menu. 
“...” Example entries 

 
Pos: 16 /TD/--- Seitenwechsel --- @ 0\mod_1173774430601_0.doc @ 283 @  



3 Contents 

  5 

 
Pos: 17 /TD/Überschriften/MUF/Inhalt @ 3\mod_1234794019831_79.doc @ 26261 @ 1  
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Pos: 19 /TD/Überschriften/MUF/1 Messumformer @ 3\mod_1234258401060_79.doc @ 23894 @ 1  

4 Transmitter 
Pos: 20 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

4.1. Specifications 
Pos: 21 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 6321 @ 3\mod_1241608910962_79.doc @ 32625 @ 3 
 

4.1.1. Functions and use 
The testo 6321 transmitter is suitable for the following applications, 
amongst others: 
• Air conditioning and ventilation technology 

◦ Monitoring ventilation and filtration systems 
◦ Monitoring fans 
◦ Monitoring exhaust air volumetric flow rates 

Pos: 22 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 6781 @ 3\mod_1238162497483_79.doc @ 30275 @ 3 
 

4.1.2. Scope of delivery 
The scope of delivery of the testo 6321 transmitter includes the 
following: 
•  Assembly accessories 
• Operating instructions 
• Calibration report 
• CD-ROM with operating instructions (PDF) and P2A update 

(this can only be used in conjunction with the P2A software, 
which has to be ordered separately). 

Pos: 23 /TD/Leistungsbeschreibung/Technische Daten/MUF 63xx/MUF 6781 Abmessungen @ 3\mod_1239806330094_79.doc @ 31183 @ 3  

4.1.3. Dimensions 
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 Pos: 24 /TD/Leistungsbeschreibung/Technische Daten/MUF 63xx/MUF 6321 @ 3\mod_1241601145321_79.doc @ 32604 @ 35555555555555555555 
 

4.1.4. Technical data 
Parameter 
• Differential pressure 

Accuracy1 

 
The specifications are only valid if the positive pressure is 
applied at the positive pressure connection. 

 

• 1.2 % of measuring range, additional ±0.3 Pa intrinsic error 2 
• TK slope drift = 0.05 % of measuring range per degree Kelvin of 

deviation from nominal temperature 22 °C 
• TK zeroing drift= 0 % (by means of automatic zeroing) 

 
  
 

Measuring range, resolution and overload 
Measuring range 
depending on 
version ordered 

Resolution Overload 

0 to 100 Pa 0.1 Pa 20,000 Pa 
0 to 10 hPa 0.01 hPa 200 hPa 
0 to 20 hPa 0.01 hPa 200 hPa 
0 to 50 hPa 0.01 hPa 750 hPa 
0 to 100 hPa 0.1 hPa 750 hPa 
0 to 500 hPa 0.1 hPa 2500 hPa 

                                                           
1 At 25 °C. A stabilization period of approx. 30 min must be taken into account 
upon commissioning the instrument. 
2 Measuring uncertainty in accordance with GUM: ±1.2 % of measuring range 
final value ±0.3 Pa.  
GUM (Guide to the Expression of Uncertainty in Measurement): ISO guideline for determining the 
measuring uncertainty in order to render global measurement results comparable.  

The following uncertainties are used during the inquiry: 

• Hysteresis 

• Linearity 

• Reproducibility 

• Long-term stability 

• Adjustment area/factory calibration 

• Test location 
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Measuring range 
depending on 
version ordered 

Resolution Overload 

0 to 1000 hPa 1 hPa 2500 hPa 
0 to 2000 hPa 1 hPa 2500 hPa 
-100 to 100 Pa 0.1 Pa 20,000 Pa 
-10 to 10 hPa 0.01 hPa 200 hPa 
-20 to 20 hPa 0.01 hPa 200 hPa 
-50 to 50 hPa 0.01 hPa 750 hPa 
-100 to 100 hPa 0.1 hPa 750 hPa 
-500 to 500 hPa 0.1 hPa 2500 hPa 
-1000 to 1000 hPa 1 hPa 2500 hPa 
-2000 to 2000 hPa 1 hPa 2500 hPa 

 

 
Upon delivery and following a factory reset the readings are 
shown in the display in the unit that was ordered via the 
KMAT option Fxx, see Ordering options for testo 6321 
transmitter (0555 6321) page 37.  

 

Meas. cycle 
• 1/sec 

Zeroing cycle 
• Set to 1 min at the factory 

  

Interface 
• Mini-DIN for P2A software (adjustment and parameterization 

software)  

Voltage supply 
•  3 or 4-wire (separate signal and supply lines): 20 to 30 V 

AC/DC, 300 mA power consumption 

Maximum load 
• 4-wire: 500 Ω (power output) 
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Maximal load  
• 10 kΩ (voltage output) 

Analog output 
•  0 to 1 V ± 2.5 mV (4-wire) or 
• 0 to 5 V ± 12.5 mV (4-wire) or 
• 0 to 10 V ± 25 mV (4-wire) or 
• 4 to 20 mA ± 0.05 mA (4-wire) 
• TK = 0.05 %K of measuring range per degree Kelvin of 

deviation from nominal temperature 22 °C 

Resolution of analog output 
• 12 bit 

Display 
• 2-line LCD (optional) 

Operating temperature  
• -5 to 50 °C 

Storage temperature 
• -20 to 60 °C 
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Application humidity 
• 0 to 90 % RH 

Housing, weight 
• Plastic, approx. 160 g 

Protection class 
• IP 65 only if the transmitter is wired and/or sealing plugs are 

inserted 

Directives, standards and tests 
• EC Directive: 2004/108/EC 

Warranty 
• Duration: 2 years 
• Warranty conditions: see website www.testo.com/warranty 

Pos: 25 /TD/Überschriften/MUF/1.2/2.2 Produktbeschreibung @ 3\mod_1234258723551_79.doc @ 24008 @ 2 
 

4.2. Product description 
Pos: 26 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Auf einen Blick MUF 6321 @ 3\mod_1241599865646_79.doc @ 32583 @ 3 
 

4.2.1. At a glance 
 

1 Display for showing reading 
(optional, cannot be retrofitted)  

2 Service interface (mini-DIN port) 
3 Wall bracket (on rear) 
4 Negative pressure connection 
5 Positive pressure connection 

 

6 M 16 x 1.5 screw connection, e.g. 
analog output  

 
Pos: 27 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Skalierung 6321 @ 4\mod_1252938938948_79.doc @ 50283 @ 3 
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4.2.2. Scaling 
There are three types of min./max. values: 
1 The measuring range: The maximum sensor performance is in 

this range. Measuring range, see table (below). 
2 Standard scaling:  The output signals are assigned to this 

measuring range as standard: 
◦ during delivery if no entries are made in the order code 
◦ after exchanging the unit, the measuring range recorded in 

the instrument is applied as standard. 
 

 
The transmitter even retains its scaling with the voltage 
disconnected. 

 

Measuring range, see table (below). 
3 The maximum settings for the manual scaling  

◦ The maximum limits can be calculated as follows: 
 X = difference between MIN. and MAX. value of the 

standard scaling 
 (Max. value of standard) + (50 % of X) 
 (Min. value of standard) - (50 % of X) 
◦ It is thus possible to scale beyond the measuring range, e.g. 

for the adjustment of the scaling limits to standard values of 
a PLC. 

With the alarm definition, however, the physical measuring 
range limits are decisive. 

 
 
Pos: 28 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Tabelle Skalierung MUF 6321 @ 3\mod_1241617696391_79.doc @ 32646 @   

Measuring range/ 
standard scaling  

Maximum scaling 

0 to 100 Pa -50 to 150 
0 to 10 hPa -5 to 15 
0 to 20 hPa -10 to 30 
0 to 50 hPa -25 to 75 
0 to 100 hPa -50 to 150 
0 to 500 hPa -250 to 750 
0 to 1000 hPa -500 to 1500  
0 to 2000 hPa -1000 to 3000 
-100 to 100 Pa -200 to 200 
-10 to 10 hPa -20 to 20 
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Measuring range/ 
standard scaling  

Maximum scaling 

-20 to 20 hPa -30 to 30 
-50 to 50 hPa -100 to 100 
-100 to 100 hPa -200 to 200 
-500 to 500 hPa -1000 to 1000 
-1000 to 1000 hPa -2000 to 2000 
-2000 to 2000 hPa -4000 to 4000 

 
Pos: 29 /TD/Überschriften/MUF/1.3/2.3 Inbetriebnahme @ 3\mod_1234258805768_79.doc @ 24027 @ 2  

4.3. Commissioning 
Pos: 30 /TD/Erste Schritte/MUF 63xx/Wandmontage 635x_6321 @ 3\mod_1236065568006_79.doc @ 27063 @ 3455 
 

4.3.1. Assembling the instrument 
4.3.1.1. Wall mounting 

Attaching rear panel bracket 
 

 

1. Remove locking screw (see item (4) of drawing below) and 
detach rear panel bracket from plastic bracket (see item (2) of 
drawing below). 

2. Hold rear panel bracket in assembly position and mark the three 
drill holes. 

3. Drill three holes (Ø 5 mm) and insert dowels where necessary. 
4. Screw on rear panel bracket. 

Remember that the clamping brackets (1) must face the wall. 
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Fastening instrument to rear panel bracket 

 

1. Slide plastic bracket (2) on the back of instrument onto rear 
panel bracket until it engages (see arrows). 

2. Insert screw (4) through hole (3) and screw into rear panel 
bracket. 

Pos: 31 /TD/Erste Schritte/MUF 63xx/Gerät verdrahten 6321 @ 3\mod_1241618087115_79.doc @ 32667 @ 344  

4.3.2. Wiring the instrument 
 

WARNING
Electrical voltage! 
> When routing cables, ensure that there is a space between the 

signal line and the interfering external lines. 
> If electromagnetic interference is likely, use a shielded and/or 

twisted cable. Connect the shield to the earth on the side 
facing away from the transmitter. 

> If overvoltages are likely, install overvoltage protection devices. 
 

 
 

WARNING
Electrical voltage 
Danger of injury! 
> De-energize the mains connection before connecting the 

transmitter. 
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CAUTION 

Damage to electronic components! 
> The terminal strip can be removed from the circuit board in 

order to screw on the cable ends. After wiring, be sure to 
completely attach the terminal strip on the contact pins as pre-
assembled. 

 

  

 
Only have the transmitter wired and connected by 
authorized personnel with the voltage disconnected. 

 

 
1. Loosen and remove housing screws (1). 
2. Remove upper part of housing (2) from lower part of housing (3) 

and place on a clean surface. 
3. Wire instrument (see 3-wire system page 16, 4-wire system 

page 16). 

4 Place upper part of housing (2) on lower part of housing (3) and 
tighten with housing screws (1). 

5. On instruments with display: Remove protective film (4) from 
the display cutout of the housing cover. 
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4.3.2.1. 4-wire system 
 

  

Voltage output (4-wire, 0 to 1 V/0 to 5 V/0 to 10 V)/voltage output 
(4-wire, 4 to 20 mA):  
U = 20 to 30 V DC/AC 

4.3.2.2. 3-wire system 
All ground connections are connected to one another (= one 
collective ground connection). 

  

CAUTION 

Destruction of the instrument in the event of incorrect 
polarity! 
> When connecting the voltage supply, place collective ground 

connection on PIN 2! 
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Pos: 32 /TD/Überschriften/MUF/1.6 Wartung und Reinigung @ 3\mod_1234443039129_79.doc @ 24982 @ 2 
 

4.4. Maintenance and cleaning 
Pos: 33 /TD/Produkt instand halten/MUF 63xx/Gehäuse reinigen 6321 @ 3\mod_1241092795617_79.doc @ 32303 @ 3  

4.4.1. Cleaning housing 
• Only clean the housing carefully with a moist cloth. 
• Do not use aggressive cleaning agents. 
• Do not use any solvents. 

Pos: 34 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Namur Fehlerbedingungen 6321 @ 4\mod_1253024846257_79.doc @ 50363 @ 3  

4.4.2. Namur fault conditions 
If the faults named in the following table occur, the analog outputs 
output special values that enable a general fault warning in the 
higher-level control system. The values correspond to the "Namur" 
industry standard. 

 

Status 
message in 
the display  

Class Display 
value in the 
display 

Analog output 

 4 to 20 mA 1 V 5 V 10 V 
Watchdog 
error 

Error Previous 
value stops 

3.8 mA 1.1 V 5.5 V 11 V 

Value below 
min. scale 

Underrange Reading  3.8 mA 0 V 0 V 0 V 

Value above 
max. scale  

Overrange  Reading  20.5 mA 1.1 V 5.5 V 11 V 

Pressure too 
high 

Overrange ooooo · 20.5 mA 1.1 V 5.5 V 11 V 

 Pos: 35 /TD/Überschriften/MUF/3 Parametrier-, Abgleich und Analysesoftware (P2A-Software) @ 3\mod_1234258523713_79.doc @ 23932 @ 1 
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5 Parameterizing, adjusting and analyzing 
software (P2A software) 

Pos: 36 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

5.1. Specifications 
Pos: 37 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 63xx P2A @ 3\mod_1234258967326_79.doc @ 24065 @ 355 
 

The P2A software is used for the parameterizing, adjustment and 
analysis of testo transmitters. The following applies: 
• Generally, all newer testo transmitters (as of 2007) are 

supported. 
• Included with every testo transmitter that is bought new is a CD 

that contains a free upgrade of the software, which includes the 
device drivers for all transmitters that can be attached at this 
time. 

• This upgrade can be downloaded at any time via the testo 
homepage "www.testo.com/Download/P2A". 

The software must only be bought one time, even for owners of 
several testo transmitters. 

5.1.1. Functions and use 
In the P2A software, two different file types are used: The 
instrument and the parameter file. 

Instrument file 
The parameters of a particular transmitter are stored in its so-called 
instrument file. Using this file, the parameters can be edited and the 
instrument can be tested and adjusted. 
Instrument files also contain the respective histories in addition to 
the parameter data, i.e. "log books" are kept for the previous 
parameterizations, adjustments and messages (see Transmitter 
history page 33). 

 

 
Instrument files are ".cfm" format files. 

 

Parameter file 
Parameter files are not tied to a specific individual transmitter and 
contain only parameter data/no history data. 
If you use various instruments of the same type, you can create 
parameter files once (e.g. by saving the appropriate instrument file 
as the parameter file) and transmit these onto the other 
instruments. 
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Parameter files are ".cfp" format files. 

 Pos: 38 /TD/Leistungsbeschreibung/Systemvoraussetzungen/MUF 63xx @ 3\mod_1234260654399_79.doc @ 24084 @ 3555 
 

5.1.2. System requirements 
Operating system 
• Windows® 2000 SP4 
• Windows® XP Home/Professional 
• Windows® Vista 

Computer 
• Pentium processor of at least 400 MHz or equivalent 
• 128 MB RAM 
• Graphics resolution of at least 1024 x 768  
• Unused hard drive capacity of at least 15 MB 
• CD-ROM drive 
• USB interface 
• At least Internet Explorer 5.0. 

Software 
The P2A software must be purchased and installed separately from 
the transmitter. If it is a new software version, the transmitter is 
already supported completely. Older P2A software versions can be 
updated via the P2A software upgrade (cf. product CD included 
with the transmitter). 

Pos: 39 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 63xx P2A @ 3\mod_1234260991646_79.doc @ 24103 @ 3 
 

5.1.3. Scope of delivery 
Included in the scope of delivery are: 
• P2A software 
• USB driver 

 

 
When working with the parameterizing, adjusting and 
analyzing software (P2A software), previous knowledge of 
Windows® operating systems is assumed. The description 
in this instruction manual relates to Windows® XP. 
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Pos: 40 /TD/Überschriften/MUF/3.2 Erste Schritte @ 3\mod_1234258633304_79.doc @ 23970 @ 2  

5.2. First steps 
Pos: 41 /TD/Erste Schritte/MUF 63xx/P2A/Software/Treiber installieren @ 3\mod_1234261192065_79.doc @ 24123 @ 3444 
 

5.2.1. Installing the software/driver 
 

 
Administrator rights are required to install programs and 
drivers under Windows® 2000 SP4, XP and Vista. 

 

5.2.1.1. Installing P2A software 
1. Insert CD with P2A software.  

✓  If the installation program does not start automatically: 

> Open Windows Explorer and start the file Setup.exe on the 
product CD. 

2. Follow the directions of the installation wizard. 

5.2.1.2. Installing USB driver 
 

 
Before installing the USB driver, please read the separate 
documentation that is enclosed with the USB driver CD. 

 

5.2.1.3. P2A software upgrade 
1. Insert product CD (supplied with the transmitter). 
2. Open Windows® Explorer and start the file P2A upgrade.exe 

on the product CD. 
3. Follow the directions of the installation wizard. 

Pos: 42 /TD/Erste Schritte/MUF 63xx/P2A/Software starten _6321 @ 3\mod_1242285508828_79.doc @ 32883 @ 3444 
 

5.2.2. Starting the software 
5.2.2.1. Starting the program 

> Select: [Start] > All Programs > Testo > P2A Software. 
- The program window is opened (see User interface page 21). 

5.2.2.2. Establishing a connection with the instrument 
Multiple instruments can be attached, however only one connection 
is active at all times. 

✓  USB driver is installed (see Installing USB driver page 20). 

1. Start the P2A software. 
2. Connect adapter (supplied with the P2A software) to the service 

interface of the instrument (see item 2, At a glance page 11). 
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3. Connect instrument/adapter to the PC via the USB interface. 
- The instrument file of the attached instrument is shown in the 

file list. 

5.2.2.3. Activating the connection with the instrument 
> Click on the desired instrument file. 
- The selected file is marked in colour and the connection with 

the instrument is activated. 
If a connection with the instrument is established when the program 
is started, the corresponding instrument file is marked 
automatically. 

Pos: 43 /TD/Überschriften/MUF/3.3 Software verwenden @ 3\mod_1234258679599_79.doc @ 23989 @ 2 
 

5.3. Using the software 
Pos: 44 /TD/Produkt verwenden/MUF 63xx/P2A/Software verwenden @ 3\mod_1234262654547_79.doc @ 24162 @ 3 
 

5.3.1. User interface 
 

 

1 Menu bar: 
 

Menu  Command  Explanation 
File Open Shows the Windows dialogue for 

searching and opening files. 
 Save as Saves the parameters of an 

instrument or parameter file 
under a new name. 
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Menu  Command  Explanation 
Edit Copy Copies the parameters of the 

marked instrument or parameter 
file in the cache. 

 Paste Pastes the parameters from the 
cache in the marked instrument 
or parameter file. 

View Toolbar 
Status bar 

Activates/deactivates the toolbar 
or status bar. 

? Check instrument 
connections 

Checks the connections to a 
connected instrument without the 
instrument having to be 
activated. 

 Service A text file with the most important 
information on the computer and 
the software is opened via 
Display service data. 

 Information Shows the version number of the 
P2A software. 

 
  

2 Toolbar: Shows the Windows-compliant icons for editing. 
3 File: 

 

Icon  File Explanation 

 
Symbol shows a 
transmitter 

Instrument 
file 

Instrument file 
Connection to the instrument has 
been established. 
<Type> <Serial number>.cfm 
File name should not be 
changed. 

 
Symbol shows a 
transmitter with a red 
minus sign in the upper 
left corner 

Instrument 
file 

Instrument file 
Connection to the instrument has 
not been established. 
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Icon  File Explanation 

 
Symbol shows a 
transmitter with a white 
P for parameter file in 
the upper left corner 

Parameter 
file 

<Type> <Serial number> 
<Date> <Time>.cfp 
File name can be changed. 
The name can be selected freely, 
but it is recommended that you 
retain the reference to the 
instrument. 
Parameter files are always 
marked red; the parameter 
values they contain are only 
forwarded to the instrument after 
being transmitted to the 
instrument file. 

 

4 Function buttons: Dialogues on editing and testing the 
instrument are opened by means of the buttons. 

[Change parameterization] see Changing instrument/parameter 
file page 24  
[Test/analyze transmitter] see Chapter Analyzing/testing the 
transmitter page 27 
[Adjusting the transmitter] see Chapter Adjusting the transmitter 
page 31  
[Transmitter history] see Transmitter history page 33  
5 File information: 

 

Status  Shown in the window  
An instrument file is 
selected 

Type, serial number, firmware version of the 
instrument. 

A parameter file is 
selected 

Type, serial number and firmware version of 
instrument for which the parameter file was 
created. 

Connection status Green = connection is active 
Red = connection is inactive 

 

6 Status bar: Shows the current status when editing via the menu 
bar. 
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Pos: 45 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei bearbeiten @ 3\mod_1234358080444_79.doc @ 24303 @ 34 
 

5.3.2. Editing instrument/parameter file 
5.3.2.1. Changing instrument/parameter file 

✓  The desired instrument/parameter file is marked. 

1. Click on [Change parameterization]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Change parameterization register. 
If the parameters were transmitted from other parameter files into 
the instrument file, a message is shown with which you can 
transmit the new parameters to the connected instrument using 
[Yes]. 

> If the parameters should not be transmitted, click on [No]. 
2. Change or enter parameters in the corresponding fields. 

Pos: 46 /TD/Produkt verwenden/MUF 63xx/P2A/Einheit / Analogausgang ohne Relais @ 4\mod_1244205188941_79.doc @ 44503 @  
 

Field Explanation 
Unit/ 
Analog output 

All analog outputs are parameterized in this 
mask. 
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Field Explanation 
Unit/analog output 
(graphic) 

Unit: 0 to 1 V/5 V/10 V or 4 to 20 mA. 
Vertical: Current version of the analog output 
(cannot be changed). 
Horizontal: Min./max. scale end points of 
selected unit. 
The curve changes in accordance with the 
entered value of scale minimum and 
maximum. 

Scale minimum/ 
maximum 

The endpoints of the scaling can be selected 
up to the stored scale minimum and 
maximum. In the process, scaling can take 
place beyond the measuring range in order 
to adjust the analog output to the customer 
system, see Scaling page 12.  

Unit Selection of the physical unit. 
When changing the unit, standard values are 
set for scale minimum and maximum. 

Signal delay 
(graphic) 

Curve changes according to the set signal 
delay. 

Signal delay Time interval in stages 1 – 15: 
1 = no delay 
15 = longest delay. 
The signal delay is added to the reaction time 
of the sensor. The signal delay shows 
averaging over the time interval of the 
selected stage in seconds: 
Example 
Stage 10 = average of the readings from the 
last 10 seconds. 

 
 

 
The delay of the signal in relation to the change in the 
process is also significantly influenced by the selection of 
the particle filter. 

 
Pos: 47 /TD/Produkt verwenden/MUF 63xx/P2A/Gerätedatei erzeugen @ 3\mod_1237206865717_79.doc @ 29703 @ 4  
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5.3.2.2. Creating a new instrument file 
It is possible to create an instrument file without restarting the P2A 
software. 

✓  Transmitter must be connected. 

1. Click on File > New connection in the menu bar. 
- Connection to the transmitter is established. 

Pos: 48 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter speichern @ 3\mod_1234358425697_79.doc @ 24322 @ 4 
 

5.3.2.3. Saving parameters 
Parameters can be saved in new parameter files. 
1. Mark instrument/parameter file. 
2. Click on File > Save as in the menu bar. 
3. Select storage location and enter the file name. 
4. Click on [Save]. 
- The new parameter file is shown in the file list. 
Only the parameters are saved from an instrument file; the history 
data are not adopted. 

 

 
The original name (Instrument type, Serial number) is 
suggested with the current date/time as standard, e.g. 
"testo 6321 01234578 061120 1403.cfp". 
For a standard installation, the files are saved under 
"C:\Documents and Settings\All Users\Shared 
Documents\P2A Software". The path can differ depending 
on the version of the operating system. 

 
Pos: 49 /TD/Produkt verwenden/MUF 63xx/P2A/Parameterdatei öffnen @ 3\mod_1234358634164_79.doc @ 24341 @ 4  

5.3.2.4. Opening the parameter file 
All parameter files stored in the standard directory path are 
automatically displayed in the file list when the software is started. 
You can also open parameter files that are stored in other 
directories. 
1.  Click on File > Open in the menu bar. 
2. Select the storage location and click on the requisite file. 
3. Click on [Open]. 
- The selected file is opened. This can be changed and saved 

(see Editing instrument/parameter file page 24). 
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Pos: 50 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter kopieren/einfügen @ 3\mod_1234358826054_79.doc @ 24360 @ 4 
 

5.3.2.5. Copying and pasting parameters 
The parameters of a parameter file can be transmitted to an 
instrument file or another parameter file from the same instrument 
type. 
1. Select file from which parameters are to be copied. 
2. Click on Edit > Copy in the menu bar. 
3. Select the file which is to be modified. 
4. Click on Edit > Paste in the menu bar. 
- The parameters are transmitted to the file. 

 

 
You can also use the common keyboard shortcuts for 
copying (CTRL+C) and pasting (CTRL+V). 
Parameters can also be transmitted using drag & drop, 
where you drag the icon of the parameter file onto the icon 
of the target instrument file. 

 

5. Connect and select corresponding instrument. 
6. Click on [Change parameterization]. 
7. Confirm confirmation request. 
- Parameter data are transferred to the instrument. 

  
Pos: 51 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei löschen @ 3\mod_1234359025194_79.doc @ 24379 @ 4 
 

5.3.2.6. Deleting instrument/parameter file 
Instrument/parameter files can be deleted from the file list. 
1. Click on the file that is to be deleted with the right mouse button. 
2. Select the command Delete in the context menu. 
- The instrument or parameter file is deleted from the list. 

Pos: 52 /TD/Überschriften/MUF/x.x.x Messumformer analysieren / testen @ 3\mod_1237380874787_79.doc @ 29928 @ 3 
 

5.3.3. Analyzing/testing the transmitter 
Pos: 53 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer analysieren/testen 632x @ 3\mod_1242139284458_79.doc @ 32824 @ 4  

In this section, you can test the outputs of the connected 
instrument, read off the limit values and reset the parameters to the 
factory settings. 
The function is only available for instrument files. 
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5.3.3.1. Analyzing/testing the instrument 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Perform action: 

 

Action  Explanation 
Carry out factory 
reset 

Reset the unit, limit value and hysteresis 
parameters to factory settings (see below). 

Test analog output Test channel 1 (see Testing analog output 
page 28). 

Display min./max. 
values 

Overview of the minimum and maximum 
values measured since the last reset of the 
transmitter (see Displaying min./max. values 
page 30). 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 54 /TD/Produkt verwenden/MUF 63xx/P2A/Werksreset durchführen @ 3\mod_1237379864072_79.doc @ 29887 @ 4 
 

5.3.3.2. Carrying out factory reset 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark transmitter test. 
- Current operating hours are shown. 
3. Confirm control query to perform the reset. 
- The values are reset to the customer-specific factory settings. 
4. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 55 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang testen 6321 @ 4\mod_1244461179628_79.doc @ 44787 @ 4  

5.3.3.3. Testing analog output 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark channel and test values. 
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Field/button Explanation 
Transmitter test Monitoring of analog outputs  

Current reading Readings are updated every second. 
Unit Unit according to the type of analog 

output. 
Default value Freely definable output value for the 

respective type of analog output (V or 
mA), 1 decimal place. 

[Activate] The entered defined value is 
forwarded to the analog output by 
clicking. The current reading is frozen.
A warning informs that the value is 
being transmitted to the connected 
instrument in the event of existing 
cabling. 
Now check the analog output using a 
precise multimeter. 

[Deactivate] Finish entering the electrical variables 
at the analog output. 
The analog output returns to the 
current reading again. 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
- The analog output returns to Measuring Mode again. 
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Pos: 56 /TD/Produkt verwenden/MUF 63xx/P2A/Min-/Max-Werte anzeigen 635x @ 3\mod_1242135985269_79.doc @ 32803 @ 4 
 

5.3.3.4. Displaying min./max. values 
The transmitter saves the minimum or maximum value for each 
channel (measured since the last voltage supply or since the last 
manual reset). 

✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark Min./max. values. 

 

Field/button  Explanation 
Min./max. values View the min./max. values of each channel. 

Only the values within the measuring range 
are shown. 

 
Channel Channel 1 min./max. 
Value Min. or max. value, 1 decimal place. 
Unit Unit selected in Unit/analog output. 

 

3. Reset Min./max. values. 
4. Click on [Reset min./max. values]. 
5. Confirm control query to perform the reset. 
- The values are reset to the factory settings. 
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6. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 57 /TD/Überschriften/MUF/x.x.x Messumformer abgleichen @ 4\mod_1244530152797_79.doc @ 44885 @ 3  

5.3.4. Adjusting the transmitter 
Pos: 58 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer abgleichen 6321 @ 4\mod_1244460546736_79.doc @ 44755 @  
 

This function is used to adjust an attached instrument. The 
following adjustments may be carried out using the software: 
•  Analog adjustment (entry via assistant/wizard) 
• n-point adjustment (entry via assistant/wizard) 

Pos: 59 /TD/Produkt verwenden/MUF 63xx/P2A/n-Punkt-Abgleich _6321 @ 3\mod_1242221387590_79.doc @ 32853 @ 4  

5.3.4.1. n-point adjustment 
With an n-point adjustment, the parameters at the 3-6 
measurement points are adjusted to the reference value. The 
reference conditions are obtained by using a precise pressure 
sensor that should be 5-times more accurate than the transmitter. 

✓  A precise pressure sensor (5-times more accurate than the 
transmitter, e.g. DPC precision pressure sensor from testo 
industrial services) is available. 

1. Connect positive output of the pressure sensor (3) to the 
positive pressure connection of the transmitter (2) and the 
negative output of the pressure sensor (3) to the negative 
pressure connection of the transmitter (1). 

1 Negative pressure connection 
2. Positive pressure connection 
3. Pressure sensor 

4. Connect transmitter to PC via service plug. 
5. Mark the instrument file of the connected instrument in the P2A 

software. 
6. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
7. Mark n-point adjustment. 
8. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 
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Field Explanation 

 
How much pressure 
is actually applied 

Required field: Entry of the value read off at 
the pressure sensor. 

 

 
The n-point adjustment must always be carried out to its full 
extent and in good time at all selected adjustment points.  

9. Disconnect connections between the pressure sensor and the 
pressure connections of the testo 6321. 

 
 
  
Pos: 60 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang abgleichen _6321 @ 4\mod_1244461217550_79.doc @ 44819 @ 4 
 

5.3.4.2. Adjusting the analog output 
1. Connect precision multimeter (see Wiring the instrument page 

14). 
2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 
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Field Explanation 

Default value The analog output value from the last 
performed adjustment is given at the output. 
Value of the factory adjustment: 
• Lower adjustment point: approx. 10 % of 

the max. value 
• Centre adjustment point: approx. 50 % of 

the max. value 
• Upper adjustment point: approx. 90 % of 

the max. value 
Measured analog 
value 

Required field: Entry of the value read off at 
the multimeter. 

 
Pos: 61 /TD/Überschriften/MUF/2.3.5 Messumformer-Historie @ 3\mod_1237373806926_79.doc @ 29846 @ 3 
 

5.3.5. Transmitter history 
Pos: 62 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer-Historie 6321 @ 4\mod_1244458681753_79.doc @ 44723 @  
 

Parameterizations and adjustment processes are registered in the 
transmitter with an operating hours stamp. 
In the history overviews (explained later in more detail), past 
processes and events can be made visible. 

 

 
For entries that are performed using the P2A software, the 
name of the user logged into Windows appears in the User 
field, while the date/time and operating hour are shown in 
the Date/time field. 

 

1. Mark the instrument file of the connected instrument. 
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2. Click on the [Transmitter history] button. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Transmitter history register. 
3. Click on the required entry in the list to change the display. 

 

Field Explanation 

 
Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 

Comments Type of parameter change, e.g. "Unit of 
channel 1 from Pa to hPa". 
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Field Explanation 

Selection of adjustment histories: n-point adjustments / Analog 
adjustments. 
Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 

Channel Analog adjustment: Channel 1. 

Specification Analog adjustment: Current reading. 

Multimeter Analog adjustment: Value read off at 
reference instrument. 

Offset Analog adjustment: Deviation at time of 
adjustment. 

Pressure 
specification 

n-point adjustment: Value read off at 
pressure sensor. 

Unit Unit during the adjustment. 
 

> To print out the history data, click on [Print]. 
 

 
The printing job is automatically sent to the default printer 
for the operating system. 
With [Set up printer …] a different printer can be selected 
or the printout can be edited. 
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4. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 63 /TD/Überschriften/8. Tipps und Hilfe @ 0\mod_1173789887985_79.doc @ 406 @ 1  

6 Tips and assistance 
Pos: 64 /TD/Überschriften/8.1 Fragen und Antworten @ 0\mod_1177402017078_79.doc @ 1093 @ 2 
 

6.1. Questions and answers 
Pos: 65 /TD/Tipps und Hilfe/Fragen und Antworten/MUF 6321 @ 3\mod_1241681063453_79.doc @ 32693 @  
 

Question Possible causes/solution 
Connection to instrument 
cannot be established 

Check connection cable/plug contacts 

Malfunction (with and 
without display) 

Analysis using the P2A software, see 
Analyzing/testing the transmitter 
page 27  

Adjustment is to be 
reversed 

Carry out factory reset (Test/analyze 
transmitter). 

When does a stable 
current reading appear? 

After approx. 20 seconds 

  

If we could not answer your question, please contact your dealer or 
Testo Customer Service. For contact details see the rear side of 
this document or the web page www.testo.com/service-contact 

Pos: 66 /TD/Überschriften/8.2 Zubehör und Ersatzteile @ 0\mod_1177402058734_79.doc @ 1102 @ 2 
 

6.2. Accessories and spare parts 
Pos: 67 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Zubehör Ersatzteile MUF 6321 @ 3\mod_1239975742627_79.doc @ 31715 @  
  
 

Description  Article no. 
Interface and software  
P2A software (parameterizing, adjusting, 
analyzing) incl. USB adapter 

0554 6020 

Supply  
Mains unit (desktop, wall-mounted) 0554 1748 
Mains unit (top-hat rail mounting) 0554 1749 
Hose  
Silicone hose ID 4 transparent 0086 0001, sold by 

the metre 
TYGON hose ID 4.8 transparent 0086 0031, sold by 

the metre 
Calibration  
Standard ISO calibration certificate, 
transmitter only  

0520 1000  
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Description  Article no. 
Standard DKD calibration certificate, 
transmitter only  

0520 1200 

For a complete list of all accessories and spare parts, please refer 
to the product catalogues and brochures or look up our website at: 
www.testo.com 

 Pos: 68 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Bestelloptionen MUF 6321 @ 3\mod_1239975748830_79.doc @ 31736 @ 3 
 

6.2.1. Ordering options for testo 6321 transmitter 
(0555 6321) 

 

Order code  Characteristic 
Axx Measuring range  
A03 0 to 100 Pa 
A05 0 to 10 hPa 
A06 0 to 20 hPa 
A07 0 to 50 hPa 
A08 0 to 100 hPa 
A09 0 to 500 hPa 
A10 0 to 1000 hPa 
A11 0 to 2000 hPa 
A23 -100 to 100 Pa 
A25 -10 to 10 hPa 
A26 -20 to 20 hPa 
A27 -50 to 50 hPa 
A28 -100 to 100 hPa 
A29 -500 to 500 hPa 
A30 -1000 to 1000 hPa 
A31 -2000 to 2000 hPa 
Bxx Analog 
output/supply 

 

B02 0 to 1 V (4-wire, 24 V AC/DC) 
B03 0 to 5 V (4-wire, 24 V AC/DC) 
B04 0 to 10 V (4-wire, 24 V AC/DC) 
B06 4 to 20 mA (4-wire, 24 V AC/DC) 
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Order code  Characteristic 
Cxx Display  
C00 Without display 
C01 With display  
Exx Housing colour 
and logo 

 

E01 Grey housing, testo logo in colour 
E02 White housing, without testo logo 
E03 White housing, black-and-white testo logo 
Fxx Differential 
pressure unit 

 

F01 Pa/Min/Max 
F02 hPa/Min/Max 
F03 kPa/Min/Max 
F04 mbar/Min/Max 
F05 bar/Min/Max 
F06 mm H2O /Min/Max 
F07 inch H2O /Min/Max 
F08 inch HG /Min/Max 
F09 kg/cm2 /Min/Max 
F10 PSI/Min/Max 
Kxx Languages of 
instruction manual 

 

K01 German/English instruction manual 
K02 French/English instruction manual 
K03 Spanish/English instruction manual 
K04 Italian/English instruction manual 
K05 Dutch/English instruction manual 
K06 Japanese/English instruction manual 
K07 Chinese/English instruction manual 

C 
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